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Introduction
Cisco Unified Messaging with IBM Lotus Sametime allows users to view and play Cisco Unity or 
Cisco Unity Connection voice messages directly from their Sametime client application.

In addition, IBM Lotus Notes versions 8.0.1 and later integrate Sametime features to achieve the 
following features:

• Sametime shows up in a pane within the Notes client.

• The native capabilities of Sametime—as well as Cisco Unified Messaging with Lotus Sametime 
features—can be accessed from within Notes.
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  System Requirements
System Requirements
Before installing Cisco Unified Messaging with IBM Lotus Sametime, user workstations must meet the 
following minimum requirements: 

• A supported operating system—see “Client Platforms” in the following section, “Compatibility 
Information.”

• 512 MB of RAM.

• 20 MB of free disk space.

• One of the following applications:

– IBM Lotus Notes version 8.0.1 or later (including integrated Sametime features)

– IBM Lotus Sametime version 8.0.1 or later

Compatibility Information
Cisco Unified Messaging with IBM Lotus Sametime is supported for use with the following:

Cisco Unified Messaging Systems

• Cisco Unity

– Version 8.0 with Microsoft Exchange

– Version 7.0 with IBM Lotus Domino

– Version 7.0 with Microsoft Exchange

– Version 5.0 with IBM Lotus Domino

– Version 5.0 with Microsoft Exchange

• Cisco Unity Connection

– Version 8.6

– Version 8.5

– Version 8.0

– Version 7.x

– Version 2.1

Client Platforms

• Apple

– Mac OS X 10.6.x

– Mac OS X 10.5.x

– Mac OS X 10.4.x

• Microsoft 

– Windows 7 Enterprise, Professional, and Ultimate editions 

– Windows Vista Business and Enterprise editions (MSDN version is not supported.)

– Windows XP (Service Pack 2 and later)
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  Related Documentation
• Novell

– SUSE Linux Enterprise Desktop version 10

– SUSE Linux Enterprise Desktop version 11

– Linux Desktop version 9

• Red Hat Enterprise Linux version 4

• Red Hat Enterprise Linux version 5

Note Use of the voicemail plugin on Red Hat Enterprise Linux is only supported with the IBM Lotus 
Sametime 8.0(2) standalone client.

IBM Lotus Server

– IBM Lotus Sametime Server 8.5.1 or later

IBM Lotus Clients

– IBM Lotus Notes version 8.0.1 and later (including integrated Sametime features)

– IBM Lotus Sametime version 8.0.1 and later

Note If you are using secure messaging, Lotus Sametime versions 8.0.1, 8.0.2,and 8.5 require 
hotfixes; version 8.5.1 or later do not. (See also the “Applying IBM Hotfixes for Lotus 
Sametime 8.0.1 and 8.5 (Secure Messaging Only)” section on page 7.) 

Determining the Software Version

To Determine the Cisco Unified Messaging with IBM Lotus Sametime Version in Use

Step 1 From the File menu, select Preferences. 

Step 2 In the left pane, expand the Cisco tab.

Step 3 Under Cisco, select Voicemail.

The Cisco Unified Messaging with Lotus Sametime version is displayed underneath the “Voicemail” 
label at the top of the page.

Related Documentation
The User Guide for Cisco Unified Messaging Release 8.x with IBM Lotus Sametime is available at 
http://www.cisco.com/en/US/products/ps9830/products_user_guide_list.html.
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  New and Changed Functionality—Release 8.6(2)
New and Changed Functionality—Release 8.6(2)
Cisco Unified Messaging Release 8.6(2) with IBM Lotus Sametime supports the following new features:

• Voicemail performance enhancements

• LDAP search performance enhancements

New and Changed Requirements and Support—Release 8.6(1)
This section contains information about new and changed requirements and support in the 8.6(1) time 
frame only.

(For information on new and changed requirements and support in earlier versions of Cisco Unified 
Messaging with IBM Lotus Sametime, see the applicable release notes at 
http://www.cisco.com/en/US/products/ps9830/prod_release_notes_list.html.)

Cisco Unified Messaging Systems
The following Cisco Unified Messaging systems have been added to the list of supported systems for 
use with Cisco Unified Messaging with Lotus Sametime:

• Cisco Unity Connection version 8.6

New and Changed Functionality—Release 8.6(1)
Cisco Unified Messaging Release 8.6(1) with IBM Lotus Sametime supports the following new features:

• Support for Citrix XenApp 5.0 virtualization on Microsoft Windows 2003

Note Citrix XenApp 5.0 virtualization support was tested with the IBM Lotus Sametime 8.5(2) standalone 
client with the following hotfix installed: 
ftp://ftp.emea.ibm.com/fromibm/lotus/sametime.hotfix.win32_20110811-1057.zip. Virtualization 
support was also tested with IBM Lotus Notes 8.5(1) FP5 with the IBM Lotus Sametime 8.5(1) 
embedded client.

Note Issues encountered using XenApp must be reproducible in a non-virtualized implementation before they 
will be investigated by Cisco support.

• Synchronization of Plug-in Credentials

• Secure LDAP Support

– Support for IBM Lotus Sametime 8.5(2) and 8.5(1).

– Support for IBM Lotus Notes 8.5(0) and higher.

– This feature is not supported in IBM Lotus Sametime 8.5.

• Support for IBM Lotus Notes 8.5(3)
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  Installation and Upgrade Information
• Support for IBM Lotus Sametime 8.5(2)

• Security enhancements that address an IBM Lotus Notes compatibility issue that could be used to 
expose user credentials.

• Configuration tool option for disabling the ability to forward a voicemail as an e-mail.

(For information on new and changed functionality in earlier versions of Cisco Unified Messaging with 
IBM Lotus Sametime, see the applicable release notes at 
http://www.cisco.com/en/US/products/ps9830/prod_release_notes_list.html.)

Installation and Upgrade Information
• Downloading Cisco Unified Messaging 8.6(2) with IBM Lotus Sametime Software, page 6

• Applying IBM Hotfixes for Lotus Sametime 8.0.1 and 8.5 (Secure Messaging Only), page 7

• Applying IBM Hotfixes for Lotus Sametime 8.0.2 (Secure Messaging Only), page 7

• Upgrading to Cisco Unified Messaging 8.6(2) with IBM Lotus Sametime, page 7

• Installing Cisco Unified Messaging 8.6(2) with IBM Lotus Sametime, page 8

• Configuring Cisco Unified Messaging 8.6(2) with IBM Lotus Sametime, page 9

• Synchronization of Plug-in Credentials, page 14
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  Installation and Upgrade Information
Downloading Cisco Unified Messaging 8.6(2) with IBM Lotus Sametime 
Software

Do the following two procedures in the order listed.

To Download Cisco Unified Messaging 8.6(2) with IBM Lotus Sametime

Step 1 On the web server that is going to host the update site, create a folder to hold the Cisco Unified 
Messaging with IBM Lotus Sametime files.

Step 2 On a computer with a high-speed Internet connection, go to the Unified Communications Plug-ins for 
IBM Lotus Sametime Software software download page at 
http://tools.cisco.com/support/downloads/go/Redirect.x?mdfid=282224966.

Note To access the software download page, you must be signed in to Cisco.com as a registered user.

Step 3 On the Select a Release page, expand Latest Releases, then select 8.6(2). The download button appears 
on the right side of the page.

Step 4 Confirm that the computer you are using has sufficient hard-disk space for the downloaded file. (The 
download file size appears in the download description.)

Step 5 Download the file Cisco_Plugins_8.6.1.zip to the folder you created in Step 1.

Step 6 Follow the on-screen prompts to complete the download.

Step 7 Open the folder you created in Step 1.

Step 8 From the Cisco_Plugins_8.6.1.zip file, extract the CiscoUMWithLotusST_8.6.1.1038.zip file by using 
the application appropriate for the operating system.

Step 9 Open the CiscoUMWithLotusST_8.6.1.1038.zip\UpdateSite directory that was created from the 
extracted file.

When extracted, the directory structure for Cisco Unified Messaging with IBM Lotus Sametime looks 
like this:

- features
- plugins
- web
index.html
site.xml

To Extract the Cisco Unified Communications with IBM Lotus Sametime Configuration Tool

Step 1 Go to the directory where you downloaded the Cisco_Plugins_8.6.1.zip file in the “To Download Cisco 
Unified Messaging 8.6(2) with IBM Lotus Sametime” procedure on page 6.

Step 2 From the Cisco_Plugins_8.5.1.zip file, extract the CiscoCfg-8.6.1.134.zip file by using the application 
appropriate for the operating system.
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  Installation and Upgrade Information
When extracted, the directory structure for the Cisco Unified Communications with IBM Lotus 
Sametime Configuration Tool looks like this:

- ciscocfg
- templates

Applying IBM Hotfixes for Lotus Sametime 8.0.1 and 8.5 (Secure Messaging 
Only)

Note The IBM hotfixes apply only to Lotus Sametime 8.0.1 or 8.5 depending on version in use.

Do the procedure in this section only when secure messaging is configured.

To Apply IBM Hotfixes for Lotus Sametime 8.0.1 or 8.5 (Secure Messaging Only)

Step 1 Go to the IBM website: http://www.ibm.com/support/docview.wss?rs=899&uid=swg21414050.

Step 2 Open a service request with IBM Support to obtain the hotfix as noted on the site. Include the version 
and platform information in the request.

Note Secure Messaging is supported without fixes in IBM Lotus Sametime 8.5.1 and later.

Applying IBM Hotfixes for Lotus Sametime 8.0.2 (Secure Messaging Only)

Note The IBM hotfixes apply only to Lotus Sametime 8.0.2.

Do the procedure in this section only when secure messaging is configured.

To Apply IBM Hotfixes for Lotus Sametime 8.0.2 (Secure Messaging Only)

Step 1 Go to the IBM website and obtain the required cumulative fix pack: 
https://www.ibm.com/support/docview.wss?uid=swg21425033.

Step 2 Open a service request with IBM Support to obtain the fix pack as noted on the site. Include the version 
and platform information in the request.

Upgrading to Cisco Unified Messaging 8.6(2) with IBM Lotus Sametime
There is no separate upgrade process—you install the new version of the plug-in in the same way you 
installed the previous version. See the next section, “Installing Cisco Unified Messaging 8.6(2) with 
IBM Lotus Sametime.”
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  Installation and Upgrade Information
You do not need to uninstall a previous version. The update manager in Sametime handles it.

Installing Cisco Unified Messaging 8.6(2) with IBM Lotus Sametime
There are two ways in which to install the plug-in on user workstations:

• Automatic push update—See the IBM Lotus Sametime documentation for information on setting 
up an automatic push update. We recommend using this method.

(After the push update has been set up, continue with the “Configuring Cisco Unified Messaging 
8.6(2) with IBM Lotus Sametime” section on page 9.) 

Note IBM Lotus Notes does not support an automatic push update, but you can configure your 
installation to use a Notes widget to create similar behavior. You must first run the Cisco Unified 
Communications with IBM Lotus Sametime Configuration Tool and then follow the instructions 
at 
http://publib.boulder.ibm.com/infocenter/domhelp/v8r0/topic/com.ibm.help.domino.admin85.d
oc/H_CLIENT_MGMNT_OVER.html.

• Manual installation—Do the “To Manually Install the Cisco Unified Messaging with IBM Lotus 
Sametime Plug-in on a User Workstation” procedure in this section.

(After the software has been installed, continue with the “Configuring Cisco Unified Messaging 
8.6(2) with IBM Lotus Sametime” section on page 9.)

Note After the plug-in is installed, users may be required to enter their Cisco Unity or Cisco Unity Connection 
account information in their IBM Lotus Sametime client application. Instructions are provided in the 
User Guide for Cisco Unified Messaging with IBM Lotus Sametime Release 8.x, available on Cisco.com 
at http://www.cisco.com/en/US/products/ps9830/products_user_guide_list.html.

To Manually Install the Cisco Unified Messaging with IBM Lotus Sametime Plug-in on a User Workstation

Step 1 Start the IBM Lotus Sametime client application.

Step 2 From the Tools menu, select Plug-ins > Install Plug-ins.

Step 3 In the Install/Update wizard, on the Feature Updates page, select Search for New Features to Install 
and select Next.

Step 4 On the Update Sites to Visit page, select Add Remote Location.

Step 5 In the New Update Site dialog box, in the Name field, enter Cisco Voicemail.

Step 6 In the URL field, enter the URL of the update site that hosts the Cisco Unified Messaging with IBM 
Lotus Sametime plug-in and select OK.

Step 7 On the Update Sites to Visit page, select Finish.

The Updates window opens with Cisco Voicemail listed as a feature to install.

Step 8 Select Cisco Voicemail.

Step 9 If there is an IBM hotfix available, select the IBM hotfix.

Step 10 Select Next.

Step 11 Select I Accept the Terms of the License Agreement, and select Next.
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  Installation and Upgrade Information
Step 12 If a feature verification warning appears, select Install All.

Step 13 Select Yes to restart the IBM Lotus Sametime client application.

Configuring Cisco Unified Messaging 8.6(2) with IBM Lotus Sametime
In this section, you configure the Cisco Unified Messaging with IBM Lotus Sametime plug-in for all 
users who will use it.

You can use the Cisco Unified Communications with IBM Lotus Sametime Configuration Tool for 
updating user configuration information after the plug-in has been installed.

For configuration changes to take effect, either set up Sametime to update users automatically by using 
a push update, or instruct users to update the plug-in from their Sametime client.

This section contains two procedures:

• To Configure Cisco Unified Messaging with IBM Lotus Sametime by Using the Configuration Tool

• To Manually Configure Cisco Unified Messaging with IBM Lotus Sametime on a User Workstation

To Configure Cisco Unified Messaging with IBM Lotus Sametime by Using the Configuration Tool

Step 1 Go to directory that was created in the “To Download Cisco Unified Messaging 8.6(2) with IBM Lotus 
Sametime” procedure on page 6.

Step 2 Go to the ciscocfg directory.

Step 3 Double-click ciscocfg.exe.

Step 4 In the Choose an Update dialog box, in the Directory field, enter the path of the UpdateSite directory 
that was created in the “To Download Cisco Unified Messaging 8.6(2) with IBM Lotus Sametime” 
procedure on page 6.

Step 5 Select OK.

Step 6 In the Cisco Unified Communications with IBM Lotus Sametime Configuration Tool window, select the 
LDAP tab and enter values in the applicable fields. The fields are described in Table 1.

Note Configuration of LDAP is optional. However, choosing not to use LDAP may result in some 
diminished unified messaging functionality. For example, Cisco Unified Messaging with Lotus 
Sametime uses LDAP to map phone numbers from voice messages to Sametime contacts. 
Without LDAP properly configured, phone numbers or names may display in the Name column 
rather than Sametime contacts.

Note The default LDAP settings provided are representative of common configurations. 
Administrators should determine if these settings are appropriate for their specific 
configurations and change as necessary.
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  Installation and Upgrade Information
Table 1 Fields on the LDAP Tab

Name Description

Directory Server Settings

Server Enter the name or IP address of the LDAP server.

Port Enter the number of the port used to communicate with the LDAP 
server.

Search Base Enter the base (or root) of the directory service in which to search 
for names. The value must match the one configured on Sametime 
server. If LDAP is used for the directory service, you can derive 
the setting directly from there. If Domino is used instead, find the 
equivalent search base on its LDAP interface.

Display Name Attribute Enter the LDAP attribute that is used as the display name for the 
caller.

Attribute for Lookup in Sametime Enter the LDAP attribute that is used to search for the caller in 
Sametime.

Authentication Required Select this option if authentication is required by the server.

Authentication Credentials

Distinguished Name (When authentication is enabled) Enter the distinguished name 
that is used to authenticate with the directory service.

Password (When authentication is enabled) Enter the password that is used 
to authenticate with the directory service.

Directory Usage

Non-default Community Access Enable non-default communities to use directory services to 
extend the functions to pilot communities, for example:

• Retrieve phone numbers to populate their contacts

• Show phone status for their contacts

Only one set of users data can be used. You can have two 
communities, but of the same global set of users. If the Sametime 
server for the non-default communities uses the same LDAP 
server as the default community, then identical functionality can 
be extended to contacts in those communities.

Select the applicable setting:

• Disable—Select this option so that non-default communities 
are unable to use the directory service.

• Enable for All Communities—Select this option so that all 
non-default communities are allowed to use the directory 
service.

• Enable for Configured Communities—Select this option 
so that only communities listed in the Community List field 
are allowed to use the directory service.

Community List (When Enable for Configured Communities is selected above) 
Enter the list of communities (Sametime host name or IP 
address), separated by commas, that you want to allow access to 
the directory service.
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Step 7 On the File menu in the Configuration Tool window, select Save.

Step 8 In the window, select the Voicemail tab and enter values in the applicable fields. The fields are described 
in Table 2.

Directory Type for Sametime Server

Directory Type Enter the applicable settings:

LDAP—Select this option if the IBM Lotus Sametime server 
uses an LDAP server for directory service.

If IBM Lotus Sametime uses an LDAP attribute for the internal 
user ID, select the Use Attribute as Internal ID of Sametime 
User option and enter the name of the LDAP attribute.

Domino—Select this option if the IBM Lotus Sametime server 
uses IBM Lotus Domino for the directory service.

Refer to IBM Lotus Sametime documentation for additional 
information.

Dialing Rules Files

Application Dial Rules If you will use Application Dial Rules, enter the location of the 
dial rules file. You can obtain Application Dial Rules from Cisco 
Unified Communications Manager Administration by navigating 
to the Call Routing area.

Application Dial Rules automatically strip numbers from or add 
numbers to telephone numbers that Sametime Connect dials. For 
example, the dialing rules automatically add the digit 9 in front of 
a 7-digit telephone number to provide access to an outside line.

Note A file template is available in the templates directory 
where you extracted the Cisco Unified Communications 
with IBM Lotus Sametime Configuration Tool.

This field applies only when Cisco Phone Control and 
Presence is configured with Cisco Unified Messaging 
with Lotus Sametime.

Directory Lookup Dial Rules If you will use Directory Lookup Dial Rules, enter the location of 
the dial rules file. You can obtain Directory Lookup Dial Rules 
from Cisco Unified Communications Manager Administration. 
Navigate to the Call Routing area.

Directory Lookup Dial Rule transform caller identification 
numbers into numbers that can be looked up in the directory. For 
example, the dialing rules can automatically add +140852 to 
5-digit numbers beginning with 5, so that the number 56666 
becomes +14085256666.

Note A file template is available in the templates directory 
where you extracted the Cisco Unified Communications 
with IBM Lotus Sametime Configuration Tool.

Table 1 Fields on the LDAP Tab (continued)

Name Description
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Fields that remain empty do not overwrite the Cisco Unified Messaging with Lotus Sametime 
configuration on the client, but fields with values will overwrite the Cisco Unified Messaging with Lotus 
Sametime configuration when an updated feature is installed on the client workstation.

Table 2 Fields on the Voicemail Tab

Name Description

Mail Store Connection Settings

Server Enter the applicable setting:

• For Cisco Unity, enter the name or IP address of the 
Exchange or IBM Lotus Domino server.

• For Cisco Unity Connection, enter the name or IP address of 
the Connection server.

Port Enter the number of the port used to communicate with the mail 
store.

Note Cisco Unity Connection provides a port that enables 
license-free IMAP connections. To use this port, enter 
7993, and select the Use Encrypted Connection check 
box.

Use Encrypted Connection Select this check box to use an encrypted connection to 
communicate with the mail store.

Use Sametime Credentials Select this check box if the credentials for logging in users to 
IBM Lotus Sametime are the same as the credentials for 
connecting to the voicemail system.

Read Only Select this check box to prevent the user from changing these 
settings.

Poll Interval If the server supports IMAP IDLE, the setting in this field is 
ignored.

If the server does not support IMAP IDLE, enter the time, in 
seconds, that each client waits before checking for new voice 
messages.

Mail Store Folder Settings

Inbox Folder Enter the name of the voicemail folder in the IMAP store.

Move Deleted Voicemail to a 
Separate Folder

Select this check box if the mail store has a folder for deleted 
messages that is separate from the Inbox folder.

Trash Folder If the mail store has a separate folder for deleted messages, enter 
the name of the folder for deleted messages.

System Settings

Enable Connection to Voicemail 
Web Service Server

If secure messaging is configured on Cisco Unity, select this 
check box to enable the Voicemail Web Service server.

If secure messaging is configured on Cisco Unity Connection, do 
not select this check box.

Use Mail Store Server as Voicemail 
Web Service Server

(When the Voicemail Web Service server is enabled) Select this 
check box if the Voicemail Web Service server is on the mail store 
server that is entered in the Servers field under Mail Store 
Connection Settings.
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Step 9 On the File menu in the Configuration Tool window, select Save All.

Step 10 On the File menu in the Configuration Tool window, select Exit.

Caution Confirm that you have saved your changes in the Cisco Unified Communications with IBM 
Lotus Sametime Configuration Tool window. Otherwise, all unsaved changes will be lost 
when you close the window.

Server (When the Voicemail Web Service server is enabled) If the Use 
Mail Store Server as Voicemail Web Service Server check box is 
not selected, enter the name or IP address of the Voicemail Web 
Service server.

Protocol (When the Voicemail Web Service server is enabled) Select the 
applicable setting:

• HTTP—Select this option if message security is not used.

• HTTPS—Select this option if message security is used.

Port (When the Voicemail Web Service server is enabled) Enter the 
number of the port used to communicate with the Cisco Unity 
server.

LDAP Attributes

User ID Enter the LDAP user attribute that contains the user ID in voice 
messages so that a directory search can find and display the user 
name.

Phone Numbers Enter the LDAP phone attributes that contain the caller ID in 
voice messages so that a directory search can replace the phone 
number with the caller name on voicemail.

Voicemail Player Settings

Rewind Interval Enter the time, in seconds, that a message will rewind when the 
Rewind button on the Voicemail player is pressed.

Skip Forward Interval Enter the time, in seconds, that a message will skip forward when 
the Skip Ahead button on the Voicemail player is pressed.

Feature Control

Remove “Forward Voicemail as 
E-mail Attachment” Option

Removes the ability to forward a voicemail as an e-mail 
attachment when selected.

Logging

Enable Detailed Logging Select this check box to enable detailed logging.

Caution Enable detailed logging only for troubleshooting. 
Otherwise, the logging will impact the system 
performance.

Table 2 Fields on the Voicemail Tab (continued)

Name Description
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Step 11 For configuration changes to take effect, either set up IBM Lotus Sametime to automatically update users 
by using a push update, or instruct users to update the plug-in from their IBM Lotus Sametime client.

The following procedure requires administrator-provided information.

To Manually Configure Cisco Unified Messaging with IBM Lotus Sametime on a User Workstation

Step 1 In IBM Lotus Sametime Connect, from the File menu, select Preferences.

Step 2 In the Preferences window, in the left pane, expand Cisco and select Voicemail.

Step 3 Under Account, if the following fields are blank, enter the applicable settings as your administrator 
instructs. Otherwise, skip to Step 4.

a. In the User ID field, enter your user ID.

b. In the Password field, enter your password.

c. In the Server field, enter the server name or the IP address of the mail store.

d. In the Port field, enter the port number used to communicate with the mail store.

e. Select or deselect the Use Secure Connection check box.

Step 4 If you want Sametime to display an icon indicating unheard voice messages, select the Show Global 
Message Waiting Indicator check box.

Step 5 If you want Sametime to maintain a log to assist in troubleshooting issues, select the Enable Detailed 
Logging check box.

Step 6 Select OK to accept the settings and to close the Preferences window.

Synchronization of Plug-in Credentials
Cisco UC Integration with IBM Lotus Sametime provides plug-in credential synchronization with other 
Cisco Unified Communications services such as Cisco Unified Communications Manager, Cisco Unified 
Presence, and Cisco Unity Connection. Plug-in credential synchronization ensures that when credentials 
for one service are changed, those same credentials will be automatically synchronized to other 
configured services. This service is configured using the updated Configuration Tool with the updated 
Unified Messaging and Phone Control and Presence plug-ins.

Perform the following procedure to configure credential synchronization for Unified Messaging.

Procedure

Step 1 Start the Configuration Tool.

Step 2 Select the Voicemail tab.

Step 3 Locate the area labeled Mail Store Connection Settings.

Step 4 Select the Synchronize Credentials check box.

Step 5 Select the Synchronize User Credentials Across Plug-ins option button.

Step 6 Save the new configuration.
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Note For information on configuring the Phone Control and Presence plug-in, refer to Release Notes for Cisco 
Phone Control and Presence 8.6 with IBM Lotus Sametime.

Note Synchronization will occur only for the credentials where the Synchronize user credentials across 
plug-ins option is selected

Limitations and Restrictions
• Minimum Supported Versions, page 15

• Ephemeral Ports, page 15

• Use Credentials from Sametime Check box, page 16

• Deleting a Voicemail, page 16

• Forwarding a Voicemail in IBM Lotus Notes 8.5(3), page 16

• Secure LDAP Implementation, page 16

• Secure LDAP Certificate Acceptance, page 17

• Secure LDAP and Domino Directory, page 17

• Secure Messaging, page 17

• IBM Lotus Notes Displays Dates In U.S. English Format, page 17

• IBM Lotus Sametime Displays Dates In U.S. English Format, page 17

• G.729a Encoded Voice Messages Cannot Be Played, page 18

• MWI on Phone Does Not Change to Reflect Message State, page 18

• Deleted Messages Folder Is Not Supported If the Mail Store Does Not Support UIDPLUS, page 18

• Update Sites, page 18

Minimum Supported Versions
The following are the minimum supported version of IBM Lotus Notes and IBM Lotus Sametime in 
Cisco Unified Messaging Release 8.6(2) with IBM Lotus Sametime:

• IBM Lotus Notes 8.5.1, Feature Pack 4 with IBM Lotus Sametime 8.5 embedded 

• IBM Lotus Sametime 8.5

Ephemeral Ports
The Phone Control and Presence and Voicemail plugins use a system of Ephemeral ports to communicate 
with the various server applications that form the unified solution. These server applications can include; 
but are not limited to; Cisco Unified Presence, Cisco Unified Communications Manager, and Cisco 
Unity. 
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  Limitations and Restrictions
Ephemeral ports differ from other port usage implementations in that when communication is required, 
a port is dynamically allocated. An application that uses an Ephemeral port implementation will use a 
different, available port each time communication is required. Microsoft Windows Vista, 7, and 
Windows Server 2008 make available a block of unused ports between 49152 and 65535. Microsoft 
Windows XP make available a block of unused ports between 1024 and 4999 or 49152 and 65535.

An Ephemeral port is released for reuse after the user quits the Sametime client.

Use Credentials from Sametime Check box
Users must select the Remember Password check box when logging into Sametime if the Use 
Credentials from Sametime option is selected for the Unified Messaging plug-in. If this check box is 
not selected, the Unified Messaging password will not be populated and the user cannot manually enter 
the password. This limitation exists in Sametime and cannot be fixed through the Unified Messaging 
plug-in.

Deleting a Voicemail
Users may encounter two situations when permanently deleting a voicemail.

The first situation is an error condition when they permanently delete a voicemail and then receive a new 
one. An intermittent error is displayed that states:

Connected to Voicemail with 1 error

and the new voicemail is not retrieved.

Should this situation be encountered, the user should log out and then log in. The error will be cleared 
and the new voicemail retrieved. This limitation is documented in caveat CSCtx01018.

The second situation is encountered when listening to an unheard voicemail after permanently deleting 
voicemails. The textual header for the voicemail does not change from bold (indicating an unheard 
voicemail) to regular text (indicating a heard voicemail) even though the voicemail otherwise plays 
normally. If the voicemail is selected and played again after approximately 30 seconds, the textual 
header changes as expected. This limitation is documented in caveat CSCtx01074.

Forwarding a Voicemail in IBM Lotus Notes 8.5(3)
Forwarding a voicemail using the Forward Voicemail as Attachment option causes the sound file to be 
translated into a text file and attached instead of staying a sound file. This limitation is documented in 
caveat CSCtu33503.

Secure LDAP Implementation
Secure LDAP connections are implemented using the LDAPv3 StartTLS approach. This is standard 
LDAPv3 mechanism for enabling SSL / TLS data confidentiality protection. This method uses an 
LDAPv3 extended operation to establish an encrypted SSL / TLS connection within an LDAP 
connection that has already been established.
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Secure LDAP Certificate Acceptance
Users must accept a certificate from the secure LDAP server to establish a connection. An acceptance 
dialog will be shown on computers that have not previously accepted a certificate from the server. Once 
the certificate has been accepted, the dialog will not be shown again.

Secure LDAP and Domino Directory
Secure LDAP connections are implemented using the LDAPv3 StartTLS approach. IBM Lotus Domino 
Directory does not support this approach. Secure LDAP connections to IBM Lotus Domino Directory 
are not currently supported.

Secure Messaging
Cisco Unified Messaging with IBM Lotus Sametime supports the secure messaging feature with Cisco 
Unity 7.0(2) and later, and Cisco Unity Connection 7.0(1) and later. The secure messaging feature 
provides security for voice messages by using public and private key encryption. 

IBM Lotus Notes Displays Dates In U.S. English Format
IBM Lotus Notes displays dates only in the U.S. English format when any English language is selected.

IBM Lotus Sametime Displays Dates In U.S. English Format
If users want IBM Lotus Sametime to display the date in a format for English other than U.S. English, 
do the procedure in this section.

The procedure applies only to IBM Lotus Sametime installed on the Microsoft Windows and Mac 
operating systems. This workaround does not apply to IBM Lotus Sametime installed on a Linux 
operating system, or to IBM Lotus Notes.

To Configure IBM Lotus Sametime to Display the Date in a Non-U.S. English Format

Step 1 On the user workstation, go to the applicable directory—depending on the operating system—and open 
the file:

Windows Documents and Settings\<user>\Application Data\Lotus\Sametime\.config\
rcpinstall.properties

Mac Users/<user>/Lotus/Sametime/.config/rcpinstall.properties
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Step 2 In the file that you opened in Step 1, make the applicable change:

Step 3 Save and close the file.

G.729a Encoded Voice Messages Cannot Be Played
Cisco Unified Messaging with IBM Lotus Sametime plays only voice messages encoded with G.711.

MWI on Phone Does Not Change to Reflect Message State
For environments with Cisco Unity and IBM Lotus Domino as the message server, IBM Lotus Sametime 
does not communicate changed message states so that Cisco Unity can change the message waiting 
indicator (MWI) on the phone. For example, the new-message light on the phone will not turn off after 
the message is played from IBM Lotus Sametime.

Deleted Messages Folder Is Not Supported If the Mail Store Does Not Support 
UIDPLUS

If the mail store does not support UIDPLUS, Cisco Unified Messaging with IBM Lotus Sametime does 
not support a folder for deleted messages that is separate from the Inbox folder. Voice messages in a 
folder for deleted messages on this message store has the following limitations:

• Moving voice messages to a folder for deleted messages does not turn off MWIs.

• IBM Lotus Sametime Connect shows the deleted voice messages by using the Deleted filter, but the 
phone user interface (TUI) lists the deleted voice messages as saved messages.

• Voice messages in the folder for deleted messages cannot be deleted or purged.

Update Sites
Older versions of IBM Lotus Sametime did not support simultaneous updates from multiple update sites. 
Selecting more than one update site and trying to install a feature caused a NullPointerException. This 
may have been fixed in newer versions.

Windows Change the line com.ibm.rcp.core.locale=en to one of the following:

• For Canada, enter com.ibm.rcp.core.locale=en_CA.

• For Ireland, enter com.ibm.rcp.core.locale=en_IE.

• For United Kingdom, enter com.ibm.rcp.core.locale=en_GB.

Mac At the end of the file, add the applicable line:

• For Canada, enter com.ibm.rcp.core.locale=en_CA.

• For Ireland, enter com.ibm.rcp.core.locale=en_IE.

• For United Kingdom, enter com.ibm.rcp.core.locale=en_GB.
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Caveats
The following caveats have been resolved in Cisco Unified Messaging with Lotus Sametime version 
8.6(2).

The following caveats have been closed in Cisco Unified Messaging with Lotus Sametime version 
8.6(2).

You can find the latest caveat information for Cisco Unified Messaging with Lotus Sametime version 
8.6(2) by using Bug Toolkit, an online tool available for customers to query defects according to their 
own needs.

Bug Toolkit is available at www.cisco.com/go/bugs. Fill in your query parameters by using the custom 
settings in the Advanced Settings option.

Note To access Bug Toolkit, you must be signed in to Cisco.com as a registered user.

Release notes for all versions of Cisco Unified Messaging with Lotus Sametime are available at 
http://www.cisco.com/en/US/products/ps9830/prod_release_notes_list.html.

Troubleshooting Information
• Status Bar in Cisco Voicemail Application Panel, page 19

• Creating a Problem Report, page 20

• User Unable to Play Voice Messages Because of Port Conflicts, page 20

Status Bar in Cisco Voicemail Application Panel
The status bar at the bottom of the Cisco Voicemail application panel indicates when the user is 
successfully connected to Cisco Unity or to Cisco Unity Connection. Any error messages appear as 
hypertext links, which users can select to show information about the errors and how to resolve them.

Table 3 Resolved Caveats for Cisco Unified Messaging with Lotus Sametime

Identifier Severity Component Headline

CSCtz03664 3 voicemail Voicemails loading slower with enable logging turned off 

CSCtz04064 3 voicemail Voicemail needs changes around the break idle timer 

CSCty30945 4 voicemail In-Efficient fetching of Complete Java Objects returned with LDAP 

Table 4 Closed Caveats for Cisco Unified Messaging with Lotus Sametime

Identifier Severity Component Headline

CSCua55615 3 voicemail Voicemail Plug-in doesn't appear in Sametime 8.0.x 

CSCtx54874 4 voicemail Default Sametime recognizer not recognizing expected pattern in lotus 
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  Obtaining Documentation and Submitting a Service Request
Creating a Problem Report
If any unexpected or unresolvable issues occur, detailed logging information is available that can assist 
in troubleshooting.

To Create a Problem Report

Step 1 Locate your IBM Lotus Sametime logs files:

a. From the File menu, select Preferences. 

b. Open the Cisco tab on the left.

c. Under Cisco, select the Voicemail tab.

The Logs field shows the location of the IBM Lotus Sametime logs.

Step 2 On the preference page, select the Enable Detailed Logging check box. 

Step 3 Reproduce the problem, then select Create Problem Report to collect the log files.

Step 4 When prompted, enter the directory in which you want the problem report saved.

At this location, the problem report will be saved with a filename in the following format:

ProblemReport_Voicemail_<version>_<user ID>_<timestamp>.zip

User Unable to Play Voice Messages Because of Port Conflicts
If a user is unable to play a voice message and receives an “Error attempting to play voicemail” or 
“Unable to instantiate Audio Player” message, select the trace-log-0.xml file log file.

If the log file shows a bind exception, then the Voicemail Port may be in use by another plug-in.

To resolve this problem, change the Voice Chat Port number from the Sametime Administration Console 
on the Sametime server. For steps on how to change this port, refer to the Sametime Administrator Guide.

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed 
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free 
service and Cisco currently supports RSS Version 2.0.

Cisco and the Cisco Logo are trademarks of Cisco Systems, Inc. and/or its affiliates in the U.S. and other countries. A listing of Cisco's trademarks 
can be found at www.cisco.com/go/trademarks. Third party trademarks mentioned are the property of their respective owners. The use of the word 
partner does not imply a partnership relationship between Cisco and any other company. (1005R)

Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any examples, command display output, and 
figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses in illustrative content is unintentional and 
coincidental.
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